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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and log on. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport log on page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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Using HP Enterprise Maps
You can use HP EnterpriseMaps (HP EM) tomanage your enterprise architecture. This user guide
will introduce you tomany of the key features, including:

l Getting Started and an overview of the user interface.

l How to create, edit, and view artifacts and relationships between artifacts and use the catalog
browser.

l How to create, edit, and run reports, including heatmaps and structuremaps.

l How to view the datamodel and select artifacts of interest within that model.

l How to perform administration tasks.

l How to use the integrations between HP EM and key data sources.

l How to install and use the extensions for Sparx EA and Inkscape.

l How to perform scripted XML publishing.
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Chapter 1

HP EM Documentation Library
The HP EMDocumentation Library consists of the following guides, which are available online, in
PDF format, or both. PDFs can be read and printed using Adobe Reader, which can be downloaded
from the Adobe website (http://www.adobe.com).

Click on the document link to access the PDF on the HP Software Product Manuals website. You
must have an HP Passport account.

Guide Description

EnterpriseMaps 1.00 Concepts
Guide

Provides conceptual information about HP EM.

EnterpriseMaps 1.00 User Guide Describes the HP EMUI and how to use it.

EnterpriseMaps 1.00 Installation
and Configuration Guide

Describes how to install and configure HP EM.

EnterpriseMaps 1.00 Legal Guide Provides open source and third-party license agreements
and notices.

EnterpriseMaps 1.00Workbench -
Assertion Editor Guide

Describes how to use the Assertion Editor in HP EM to
create custom assertions for use in policy management.

EnterpriseMaps 1.00Workbench -
Customization Editor Guide

Describes how to use the Customization Editor in HP
EM to customize the SOA DefinitionModel (SDM).

EnterpriseMaps 1.00Workbench -
Report Editor Guide

Describes how to use the Report Editor in HP EM to
create custom reports for use in the Reports tab.

EnterpriseMaps 1.00Workbench -
Taxonomy Editor Guide

Describes how to use the Taxonomy Editor inHP EM to
create taxonomies for artifact categorization.

EnterpriseMaps 1.00 Release
Notes

Provides HP EM feature information, installation notes
and known issues.
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Chapter 2

Getting Started
The HP EM home page starts you off with an easy-to-use set of panels to guide you through the
enterprise architecture process. This User Guide takes you throughmany common tasks as well as
detailed information on the integrations and instructions on how to install the extensions for Sparx
and Inkscape.

Note: If you are not logged in as Administrator, your home page will not include the Administration
panel.
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Chapter 3

User Interface Overview
EM provides you with an easy-to-use user interface with the following features.

Menu Tabs
Catalog: On the Catalog tab you can access themain panels, which organize HP EM functionality
through the enterprise architecture process phases, from creating artifacts by layer in the catalog,
to undertaking lifecycle and analysis tasks in the transformation phase, to governance activities.
You can list existing artifacts, create new ones, or import them from other repositories and data
sources.

Reports: On the Reports tab, you can access many artifact, policy, heatmap, structuremap, and
custom reports. You can also view Architecture reports such as Archimate Compliance and
Installed Software and Transformation reports such as Roadmaps, Investments, Project by Cost,
and Applications by Cost. Maintenance reports such as Application Costs are also available, and
you can also customize the reports that appear on your dashboard. For more information, see the
Reports section.

Navigator: On the Navigator tab, you can view a diagrammatic view of your architecture and select
an artifact that you wish to display as the center of the view.
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Administration: On the Administration tab, which appears if you are logged in as Administrator,
you will seemany user management, configuration, governance, and customization options.

Navigation Tabs
After you select and open an artifact of any type, the following navigation tabs appear on the left
side of your page view:

l Overview: Shows Relationships and Latest Events.

l Documentation: Shows any documentation that you wish to add to an artifact.

l Tree View: Shows relationships and approvals in a tree view and provides buttons to access
additional views, for example Show Impact and Navigator, which will open the related views for
the selected artifact.

l Lifecycle: Shows details on the artifact's lifecycle. If there is no Lifecycle process assigned,
you can use the Start Governance action to start it.

l Discussion: Add, edit, or view a comment that others will see when they access the artifact.

l Categories: Add, edit, or view a category and description.

l Specification: Add, edit, or view any associated specifications.

l Compliance: View any associated policies and the level of compliance with those policies.

l Access Rights: Add, edit, or view any associated access rights.

l Contacts: Lists the contacts associated with the selected artifact, for example Architect,
Developer, Administrator, or Project Manager.

l History: Lists the revision history table for the selected artifact, including revision, date, actor
name, lifecycle stage, and lifecycle process.

l Relationships: Lists the outgoing and incoming relationships to the selected artifact.

l Metrics: Lists any associatedmetrics for the selected artifact.

HP EM (1.00)Page 14 of 94



Chapter 4

Catalog
The HP EM catalog panel is accessible to you through the Catalog tab home page. It includes the
following layers and associated artifact types that you can create or modify:

l Business Layer:
n Capabilities & Functions

n Services

n Processes

n Roles

l Application Layer:
n Services

n Components

n Interfaces

l Technology Layer:
n System Software

n Interfaces

n Nodes & Servers

You can create or modify artifacts on each layer. Artifacts are thereby available as inputs for reports
that you create by using the Reports tab features or to visualize by using the Navigator.

Data Sources
HP EM includes integrations with many data sources that you can access directly from the Catalog
tab catalog panel. These includemodeling tools, other HP solutions such as HP PPM andHP
uCMDB, as well as CSV and XML file importing, and direct imports from other HP EM instances.
For more information, go to the Integrations section. Data sources include:

l EA Modeling Tools: You can edit the whole repository in an external diagramming tool where
the data will be bidirectionally synchronized between HP EM and the tool project space. Out of
the box you can integrate with Sparx Enterprise Architect. For more information, go to the Sparx
EA Extension section.

l Project & Portfolio Management: It is easy to connectHP EM to project and portfolio
management solutions to import project and financial information, which enables you to analyze
data in a broader IT perspective, including the application and technology layers of the enterprise
architecture. HP EM is integrated with the following PPM servers: Cloud PPM. Out of the box
you can integrate with HP Project and Portfolio Management, however, other systems may be
supported as well. Contact your HP sales representative to request an extra integration
connector license.

l CMDB: To be able to analyze the costs, impacts, and dependencies of IT infrastructure on your
business, you can integrate HP EMwith a configurationmanagement database (CMDB). This

HP EM (1.00)Page 15 of 94



User Guide
Chapter 4: Catalog

allows the system to get information about servers and software running on it as well as enabling
you to connect these objects to application and business architecture. This also enables you to
control the lifecycle of these entities. HP EM is integrated with the following CMDB servers:
Cloud uCMDB 9.03. Out of the box you can integrate with HP Universal CMDB, however, other
systems may be supported as well. Contact your HP sales representative to request an extra
integration connector license.

l CSV Files: You can import CSV files into HP EM. If you have installed HP EM on your local
machine you can find a command line tool for CSV file import in the following location:
INSTALL_DIR\client\bin\csvImport.bat[sh]. You can also download the dedicated CSV importer
distribution, which will enable you to use the csvImport command line tool. Note: You can also
export CSV files by using a context action directly from HP EM tables.

l XML Files: You can publish XML files into HP EM by using the File Import function. The XML
file is analyzed and decomposed into artifacts based on a configuration file stored within script
artifacts. This configuration is customizable and you can define your own for your custom XML
schemas.

l HP EM Federation:You can selectively export some artifacts (a whole plateau for example)
from another HP EM instance by selecting the desired artifacts in the catalog browser and
clicking the Export context action. An archive file is produced. You can import the archive by
using the Import Repository Archive feature. This enables you to transfer data betweenmultiple,
even disconnected instances of HP EM. In a similar way, youmay export whole HP EM
domains.

CSV File Export and Import
EM can export and import data in the Comma-Separated Value (CSV) format. This is useful if you
want to consolidate data from spreadsheets or relational databases. You can also edit multiple data
sets efficiently in spreadsheet format and offline and send the data back to EM in one step.

If you want to populate a simple collection from a spreadsheet file, a good practice to begin is to
create one artifact in the HP EM collection by using the Catalog, and then you can open the
collection list, select it, and then use the Save as CSV function to access the CSV file from HP
EM. You can then open the result in Excel, addmore data in the specified form according to the first
record, and then use the CSV import tool to publish all the data inside HP EM. For more information,
see the procedures listed in this section.

Exporting CSV Files
To export CSV data from HP EM:

1. Open the Catalog in a browser.

2. If the collection you are interested in is empty, create the first artifact so that the exported CSV
file contains an example data row.

3. Open the collection you are interested in either by searching for it in the Search box or by
opening the collection from the Catalog panel. For example, to open the Business Function
collection, select Capabilities and Functions from the Catalog panel list and perform your
search by clicking the Filter menu to open the Search page. Then you can the Business
Function value from the Artifact Type selector and click Search.
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l Option A: Using theMenu Bar Search Field.

l Option B: Using the Catalog Search Page

4. After you have located and opened the collection you are interested in exporting, click theMore
Actions button (e.g., the button with three dots next to the Edit and Delete buttons), and click
Save as CSV. This will start the download of data in CSV format from the table to your local
computer.

5. Open the downloaded CSV file in a spreadsheet editor, such as Excel. The first row is a header
that specifies themapping of data in HP EM. It helps you to learn how to link the data in
specific columns to properties, relationships, etc.

6. Remove unnecessary and redundant headers. For example: delete all columns but keep the
following headers: businessFunctionStatus, revision, domainId, owner, description, keyword,
revisionCreator, name. Add new data to complete the collection in spreadsheet, and when you

HP EM (1.00)Page 17 of 94



User Guide
Chapter 4: Catalog

are finished, make sure to Save as CSV. Once you do this, you are ready to Import back into
HP EM.

Importing CSV Files
To import CSV files, first decide what type of information and relationship data you want to import
as well as how you would like to view the results of your import mapped into HP EM repository.

If you are an administrator or have administrator role privileges you will find the CSV Importer
command line tool in the EM_HOME\client directory. If you are not an administrator, you can ask
your administrator to archive the tool and share it with you so that you can access it.

To get the CSV Importer command line tool and then run it:

1. Unzip the archive and open a command-line shell and change to the client/bin directory. The
tool depends on Java 1.7, somake sure you have access to the java command at the PATH
variable.

2. Call csvimport.bat or csvimport.sh to get help messages displaying the command-line options.

3. Type the commandwith at least host, user, password, sdmName and file parameters to your
environment. For instance, “csvimport -host http://hpdemo/em -user admin -password changeit
-file businessFunctions.csv –sdmName businessFunctionArtifact”

4. The CSV import of Business Functions from CSV file starts. The tool will log all events related
to the progress and status of the import.

5. When you refresh your browser, you can view the results imported into the HP EM collection.

Catalog Browser
The HP EM catalog browser is the place for viewing artifacts by artifact collection type and
Archimatemodel layer.
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1. To open the catalog browser, click Catalog > Artifacts >Show More.

2. To open a collection of artifacts, click the type of artifact that you want to view. In this
example, click Servers on the Technology Layer:

Tip: You can pin the Server artifact collection to your Artifact menu, by clicking the Pin next to
the Server collection. Pinning a collectionmakes it quick and easy to select:

3. After you select the artifact collection you want to view, the collection page opens. In this
example, the Server collection is shown:
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4. To customize your view, you can sort, filter, andmanage columns. You can use controls at the
bottom of the collection page to control the page size and amount of description displayed.

5. To perform bulk operations on artifacts in the collection, you can use the toolbar at the top of
the collection page:

6. You can set up custom filters, such as a filter for favorite artifacts or artifacts that you own:
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Creating Artifacts
You can use HP EM to create new artifacts and the attributes and relationships that impact those
artifacts.

To create a new artifact:

1. Click Catalog > Create > Show More to open the catalog browser Create Artifact window.

2. Select the artifact type that you want to create. The new artifact opens. This example shows a
Business Function artifact on the Business Layer.

3. Enter the name of your new artifact. By using the text editor, you can also add a description and
status.
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3. In the Documentation area, you can attach or link to any associated documentation.
Documents that you load are viewable on the Documentation tab.

4. To add documentation from an existing artifact, click the Add Existing Documentation icon.
The Select Artifact window displays a list of documentation artifacts to choose from.

5. To add a link to documentation from aweb resource, click the Link aWebResource icon. The
Add Document Reference window opens and you can use it to enter the document URL, the
document type, and any text or keywords that you want to appear with the link.

6. To attach a documentation artifact directly, click the Upload a Local File icon. The Attach
Document window opens and you can use it to enter the document source location, the
document type, the server folder, and the location where the document should reside after
upload, as well as keywords that you want to enable so that users can find the document. In
this example, the document types are shown.
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7. Click Save to save the new artifact that you created. Your new artifact record is displayed and
you can add or modify attributes and relationships using the tabs. Documentation artifacts are
shown on the Documentation tab.

Searching for Artifacts
HP EM enables you to perform artifact searches quickly and easily from every page.

To perform a basic search:

HP EM (1.00)Page 23 of 94



User Guide
Chapter 4: Catalog

1. Enter the text to search for in the Search box.

2. For example, if you search for the word "finance," a drop-down list of results is displayed.

3. Click on the artifact you are interested in to open the Artifact details page.

To perform an advanced search:

1. Enter the text to search for in the Search box and press Enter. The Search page opens showing
the text you searched for. In this case, the search time "finance" is shown.

2. To refine your query, use the text field to add additional search terms, key words, or to add
criteria.
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3. If you want to save the Search for future use, click Save. The Save Search box opens.

4. Type the name of your search, and then click Save. You can access your search at any time
by navigating to the URL address provided. You can also share the search URLwith others.

Once you have saved a search, it is displayed every time you click Load in the Search page.
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Viewing Artifacts in the Data Model
The HP EM datamodel is based on the Archimatemodeling language specification and consists of
artifacts grouped by type and layer, as well as artifact properties and relationships.

You can view the datamodel by logging in to HP EM and viewing the Archimate Introductory
Viewpoint that displays themodel's layers and selected artifact types.

You can view a complete list of artifacts by accessing the catalog browser. Select
Catalog>Artifacts>Show More.
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The catalog browser opens and displays all of the datamodel's artifact types grouped by Archimate
layer.

Relationship Editor
The HP EM relationship editor enables you to view andmodify artifact relationships directly.
Relationships can be those predefined within the ArchiMatemodel or you can add new
relationships. Both ArchiMate and non-ArchiMate relationships are shown on theOverview tab
view. You can add new ormanage relationships by using the Relationship tab view.

Creating and Managing Artifact Relationships
Relationships are created according to the HP EM datamodel. Each relationship that you create
will have another paired artifact and eachmember of the paired relation is assigned a unique name,
representing the outgoing and incoming relation between artifacts.

An outgoing relation between A and B automatically implies the corresponding incoming relation
between B and A. Outgoing relations are properties of source artifacts (A), whereas incoming
relations are projections of outgoing relationships to target artifacts (B).

Youmay want to assess the outgoing and incoming relationships listed for a selected artifact in
order to navigate in the data and learn the relationship structures of the artifact.

To view the outgoing and incoming relationships of a selected artifact:
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1. Select the artifact in the Catalog Browser or in the Navigator, and then open the artifact.

2. Click the Relationship tab. The artifact's relationships are shown, grouped by direction.

Create Artifact Relationships
To add relationships to existing artifacts or create new artifacts to relate to:

1. Select the artifact in the Catalog Browser or in the Navigator, and then open the artifact.

2. There are New and Add buttons available next to the relationship type that you can use to
create a new artifact or link to existing artifacts.

3. When you click the New button, the available artifact types will appear in amenu. Only an
applicable artifact type is visible when you click the New or Add buttons. After establishing a
relationship to one or more artifact(s),themenu is replaced with a list of the existing
relationships.

For example, when you click New on the Triggers relationship type, the available typemenu
might display Business Event, Business Interaction, and Business Process as available
artifact types.
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4. For artifact types that already contain data, the New and Add buttons will be hidden from view.
You can addmore artifacts to this relationship type by clicking on the relationship type name.
You will see a separatemenu for managing the relationship, which includes the option to view
the relationships in a table view:

5. If you choose to view in Table View, each row has a context menu to open an artifact in the
Catalog or Navigator:
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Remove Artifact Relationships
To remove existing artifact relationships:

1. Select the artifact in the Catalog Browser or in the Navigator, and then open the artifact.

2. From theOverview tab, you are able to remove the link between the selected artifact and
another artifact. For removing a specific artifact link from a current artifact, right-click on the
artifact you want to remove, then remove it by selecting the ‘Unlink from this artifact’ option.

3. You can also remove a set of artifacts linked to a the selected artifact while in the Table view,
simply by selecting each artifact you wish to remove from the list.
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Non-Compliant Relationships
HP EM enables you to create relationships between compliant and non-compliant artifacts.
Artifacts that are non-compliant with the Archimate-based HP EM datamodel are shown in the
artifact view, however some of the relationships can be noncompliant according to the datamodel.
These are shown in the artifact view, below themain Relationship Editor component:

Relationships: Overview Tab View
TheOverview tab shows you two types of relationships: Archimate standard relationships in the
Relationships area, and Non-Archimate standard relationship in the Archimate Non-compliant
Relationships area. The example shows an application service artifact.

If you havemany relationships defined by a single relationship type, only a few artifacts are shown
on the artifact overview page. If you want to show more relationships, you can click theMore button
to show 10 artifacts at one time.
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Themost recently modified artifact will be displayed first on the list of relationship artifacts. The
quantity of displayed artifacts after clickingMore is decided by a system property titled
platform.ui.relationship.artifact.max in system properties. Changing this value determines how
many artifacts is shown.

Relationships: Relationships Tab View
The Relationships tab shows you lists of an artifact's relationships by Outgoing and Incoming. The
example shows an application service artifact.
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Transformation
The HP EM transformation panel is accessible to you through the Catalog tab home page. It
includes the following layers and associated artifact types that you can create or modify:

l Implementation and Migration:
n Roadmap

n Projects

n Plateaus and To-Be

n Deliverables

l Lifecycle:
n My Tasks

n Processes

l Analysis:
n Impact and Dependencies

n Investments

n Navigator

l Favorite Projects: You can select projects of interest to you in the catalog andmark them as
favorites so that they are easy to access from the home page. If you do not have any projects
marked, the favorites list will be empty.

You can create or modify artifacts on each layer. Artifacts are thereby available as inputs for reports
that you create by using the Reports tab features or to visualize by using the Navigator.
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Governance
The HP EM governance panel is accessible to you through the Catalog tab home page. It includes
the following layers and associated artifact types that you can create or modify:

l Motivation:
n Drivers

n Goals

n Demands & Requirements

l Policy and Compliance:
n Reports

n Principles

n Policies

l Favorite Policy Reports: You can select policy reports of interest to you in the catalog and
mark them as favorites so that they are easy to access from the home page. If you do not have
any policy reports marked, the favorites list will be empty.

You can create or modify artifacts on each layer. Artifacts are thereby available as inputs for reports
that you create by using the Reports tab features or to visualize by using the Navigator.
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Administration
On the Administration tab, which appears if you are logged in as Administrator, you will seemany
user management, configuration, governance, and customization options.

User Perspectives
New perspectives can be granted for one or many UI Roles in HP EM.

Each unique User Perspective is defined by the Administrator, and allows access tomany different
views and a variety of artifacts in the UI. The Administrator can grant the User Perspective to an
existing user, or can create a new UI Role and define a User Perspective for the new user.

You can do the following sequences of operations to customize your user experiences:

l Create a new UI Role, create a new Perspective, andGrant a new Perspective to an existing UI
Role.

l Create a new Role and assign a new UI Role to this role.

l Create a new User and assign a new Role for the user.

After following these steps, an assigned user will have access to a new perspective in theHP EM
User Interface.

Create New User
To create a new Internal User in HP EM, use the following procedure:

NOTE: This new user cannot log in until the Administrator creates and defines the user from LDAP
or the user configuration file.

1. Log in as the Repository Administrator, and then navigate to the Administration tab.

2. Open User Management > Users.

3. On the Users page, click the Create User icon to create a new user.
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4. Enter the information about the new user such as Name, Description, Login Name, email, and
Contact Information.

5. When you finish, click Save to save the new user. The resulting page will display the New
User.

6. Now the Administrator needs to change the RoleMembership of the user. On the New User
view page, go to the Roles By Domain section. Find the role that the new user belongs to, and
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click the Change link.

7. In the Change RoleMembership dialog, select New Role, and then click the Set button to save
the changes.

Create a New User Perspective
You can create a new perspective for users in HP EM, which changes the user's view of the
artifacts and the data available to that user.

1. Log in as the Repository Administrator, and then navigate to the Administrator tab.

2. Navigate to the Customization tab and click Customize UI.

3. In the Customizationmenu, click Manage UI Roles.
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4. In theManage Tabs page, select Add Tab > Input Tab name and Tab hint, and then click Add.

5. Navigate to the New Perspective tab. Click on the Customize icon and add the components
and artifacts you want to make available in the user's new perspective.

6. Click on theManage Customizations link in the Customizationmenu to open theManage
Customizations page, and then release all changes.
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7. When you are finished, click Exit CustomizationMode.

Create a New UI Role
Create a new UI role in HP EM using the following steps:

1. Log in as the Repository Administrator, and then navigate to the Administration tab.

2. Open Customization, and then click Customize UI.
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3. In the Customizationmenu, open UI Roles.

4. In the UI Roles page, click the Create UI Roles button.

5. Enter the Role Name, and then select Tabs Access Granted for the tabs you wish the role to
have access to.

6. When you finish, click Save to save the UI Role. The resulting page will display the new UI
Role.
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Assign Users to a Role
You can assign a user to a distinct role in HP EM.

1. Log in as the Administrator, and then click the Administration tab.

2. Open Customization, and then click Customize UI.

3. In the Customizationmenu, open UI Roles.

TheOverview sidebar will open, where you can view the information page for the selected
user.

4. In the Roles By Domain section, click the Change link. Note: Make sure to assign each user to
the correct domain.

5. On the Change RoleMembership page, select the roles that you want the User to be assigned
to, and then click Set. The user will see the new perspective in their UI the next time they sign
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in.

Import External Users
To import a new External User into HP EM, use the following procedure:

NOTE: This procedure is used when the HP EM server is already installed with LDAP.

1. Log in as the Repository Administrator, and then click the Administration tab.

2. Click User Management > Users to open the Users page.

3. On the Users page, click the Import button to import users.
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4. Select the users that you want to import, and then click the Select button to finish importing
users.

Lifecycle Overview
Artifacts in EM go through several stages from candidate through development, implementation,
and eventually deprecation and reuse. Each stage has own specific features and each organization
has different detailed requirements for these different stages. The stages can be divided into
development and runtime stages. Before an artifact is allowed tomove from one stage to another,
all necessary policy requirements and approvals must be in place.

In EM lifecycle processes are defined and given policy, task, and approval requirements by an
administrator. These processes are then either automatically or manually applied to artifacts.
Manual lifecycle tasks can be assigned to different users and can have policies that must be
validated before a task is completed. Policies as well as permissions can be associated with the
lifecycle process stage.

When all the requirements and tasks are complete, the artifact owner makes a request to move the
process to the next stage. If the administrator has assigned approvers, they are notified and are
required to vote on approval. Depending on the transition type, the governed artifact moves to the
next stage and the lifecycle automatic actions defined for these stages are triggered.
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Reports
HP EM provides many reports that you can run based on the artifacts in your enterprise architecture
datamodel. On the Reports tab, you can access many artifact, policy, heatmap, structuremap, and
custom reports. You can also view Architecture reports such as Archimate Compliance and
Installed Software as well as Transformation reports such as Roadmaps, Investments, Project by
Cost, and Applications by Cost. Maintenance reports such as Application Costs are also available,
and you can also customize the reports that appear on your dashboard.

The report type that you choose depends on the results, data format, and granularity that you
require. The following are the report types to choose from:

l Artifact Reports

l Policy Reports

l Viewpoint Portlet Reports

l Heatmap Reports

l StructureMapReports

l Policy Radar Reports

l Custom BIRT Reports

All reports are customizable whenever required and you can create or deploy them without needing
to restart EM. All report types use DQL to collect by query the data to display. DQL is an SQL-like
language where tables aremapped to EM artifact types and columns mapped to artifact properties.
Using DQL is much easier than using SQL since it does not require knowledge of the EM database
schema. DQL by default also abides by artifact access rights, so that only artifacts that the current
user is permitted to view are part of the results returned by the query.

Artifact Reports
HP EM artifact reports provide table views of the artifact data contained in the HP EM repository.
The report is designed and used directly in the HP EMwebUI. The artifact table represents the
result of a DQL query that is part of the report definition. Artifact reports are re-calculated every time
the user accesses the report’s web UI page.
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Viewing Artifact Reports
To view artifact reports:

1. Log in to HP EM and select the Reports tab.

2. Select the All Reports > Artifact Reports menu, which shows any favorite reports as well as a
Show More link.

2. Click Show More to open the catalog browser. The catalog browser lists all reports and also
allows you to pin or unpin a particular report as a favorite onto the Artifact Reports menu.
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3. Click Projects to view the artifact report called Projects, which is used to review projects and
their status and content data. The Projects report is a table with columns that were defined by
associated DQL queries.

4. Make any modifications that you want. Column headers contain text fields or list boxes that
allow you to perform additional filtering. A column’s context menu appears when you click the
right side of the column header. Themenu lets you choose the sort order or make columns
visible or invisible. The columns can be resized by moving the line between them. You can also
reorder the columns by dragging them.

Defining Artifact Reports
Artifact reports are defined as a part of the HP EMwebUI. An administrator can change and
customize the web UI directly using web UI. In this example, we will look at how to view ormodify
the definition of the Projects report.

To define an artifact report:

1. Log in to HP EM as administrator and select the Administration tab, and then select the
Customize UI menu item from the Customizationmenu. The webUI switches to
customizationmode, in which all pages are editable. A customization box appears on the right
side of every page.

2. Click the Reports tab.
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3. Once you click the Reports tab, the Customization box changes to include artifact report-
related items. Click List of Reports. A list of all artifact reports is displayed; click the Projects
link from the list.

4. The artifact report page is shown in the customizationmode. It renders the results and displays
Customize links at the top of each customizable section. The Customize link above the results
table opens a window that shows an XML representation of the UI customization data that
defines the report.
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5. Click the Edit Report link in the header of Projects report page to access the report definition in
Edit Report view.

6. In the Edit Report view, you can define and test the DQL query that creates the resulting table
data. You can preview the data as you tune the query. When you finish, click the Next button at
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the bottom of the page below the project list.

7. Specify the layout of columns of the result table. You can edit column names, organize
columns in sections, reorder them, or make them visible/invisible by default. You can preview
by using the Refresh button. When you finish, click Finish. Alternatively, if you want to have
more control over when your changes are published to users, click Cancel.

8. If you click Cancel, you remain in the customizationmode of the web UI. Changes that you
made in the web UI are visible only to you as an administrator. If you want to make your
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changes visible to all users, you can release them in a page that appears when you click the
Manage Customizations link in the Customization box. Click the Exit CustomizationMode link
when you are ready to exit customizationmode.

Policy Reports
HP EM policy reports are used to report the levels of policy compliance of the artifacts in HP EM
repository. The report is designed and used directly in the HP EMwebUI. You can select the
policies to validate as well as the filter that specifies what artifacts and data to include in the
validation directly in the web UI when you define the report. The report’s results are cached in the
HP EM repository. Users always view results from themost recent calculation of the report.

Viewing Policy Reports
To view policy reports:

1. Log in to HP EM and select the Reports tab.

2. Select the All Reports > Policy Reports menu, which shows any favorite reports as well as a
Show More link.
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3. Click Show More to open the catalog browser. The catalog browser lists all reports and also
allows you to pin or unpin a particular report as a favorite onto the Policy Reports menu.

4. Click Archimate Compliance to view the policy report called Archimate Compliance.

Defining Policy Reports
Policy reports are defined as a part of the HP EMwebUI. In this example, we will look at how to
view ormodify the definition of the Archimate Compliance policy report.

To define a policy report:
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1. Click the Definition tab on the policy report page to see how the report is defined.

It shows the Search Criteria that are used to filter artifacts subject to policy validation, and a
list of Technical Policies that must be validated against the artifacts. An administrator can add
or remove technical policies using a toolbox that appears above the list.

2. Click the pen icon in the toolbox on the right side to edit the report and view other important
report definition items. The Edit page lists general fields that specify the report name,
description, and target compliance by percentage. The target compliance field is used to
indicate the overall goal of the policy report in percent of artifacts that should be compliant.

3. The Artifacts to be Validated section allows you specify a filter on which artifacts you want to
validate. You can edit, remove, add, or clear criteria using the controls in this section. By
clicking the Preview Results button, you can see artifacts that match the criteria. If required,
click the Save button at the bottom of the page to save your changes.
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4. You can also create a new policy report by selecting the Reports tab, and then clicking Create
> Policy Reports. This will allow you to specify all the details of a new policy report on a single
page.

Calculating Report Results
Policy report results are cached in the HP EM repository. Depending on the number of policies and
resources being validated, it can take an hour or more to calculate the results. Users who are
viewing the policy report are informed that the report might not be up-to-date. Recalculation of the
policy report is started in the following ways:

l Manually: the user manually recalculates the report. An associated action is available in the
Overview tab of the report.

l By Automatic Task: HP EM starts a Policy Report Validation task every day around 2:30 AM.
The actual timemay depend on the time zone of the server on which the HP EM application is
running.

To check automatic Policy Report Validation task details:
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1. Log in to HP EM as administrator and select the Administration tab, and then select the Tasks
menu item on the Configurationmenu.

2. Click the Policy Report Validation Task link on the Tasks page. If you cannot see it on the
page, switch to a table view by using the associated Show Task List toolbar action. The Policy
Report Validation Task page shows that the task is scheduled along with a table of the
execution history.

3. Click Edit Schedule on the toolbar to open the Edit Schedule dialog in which you can view and
change the scheduling details of the task.

Archimate Compliance Report Structure
The Archimate Compliance policy report consists of three subreports:

l Overview: shows the percentage of compliant and non-compliant artifacts in a pie chart as well
as a list of the top 5 artifacts with the worst compliance level. It is accessible when you click the
Overview on the left side of the report page.

l Results: shows an index table with columns containing clickable artifact names, artifact types,
compliance status (Compliant/Non-Compliant), artifact compliance (0 – 100 percent), number of
problems found, and a link to details about policy calculations. It is accessible when you click
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the Results tab on the left side of the report page.

l Artifact Results: shows a table with policy calculation details by artifact. Each row of the table
represents a technical policy included in the report definition. It contains a clickable name,
compliance status, and the number of errors and warnings. It is accessible when you click on
the View Report link in any Results row or the Overview subreport.

Each row starts with a clickable plus symbol (+). When clicked it expands a row to show a full
textual description of all errors are warnings.

Heatmaps
You can use the HP EM heatmap portlet to create graphs of your data where individual values
contained in amatrix are represented as colors. Planned cost is shown by the relative size of the
rectangular areas and project health is shown by the color shading of the rectangles. Heatmap
reports are updated immediately when there is a change in the data reported. HP EM provides two
Heatmap reports out of the box:

l Applications by Cost report shows the Annual Cost Total(s) of selected projects.

l Projects by Cost report shows Planned Cost of selected projects (shown).
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A heat map is defined in the web UI using amanaged server-side script that specifies how the data
and its two dimensions (that is, planned cost and project health) are calculated and visualized. The
heat map is also shown directly in the web UI, either as a portlet (an area of the HP EM home page)
or as a standalone report. Heat map reports are recalculated every time the user accesses the
report’s web UI page.

Create or Edit a Heatmap Portlet
To create a Heatmap portlet, first create an embedded script with Heatmap Portlet execution on
type.

1. On the Administration tab, go to Customization > Manage Scripts.

2. Click the Create new script icon to open theManaged Script editor.

3. Create a new Script in JavaScript and select Heatmap Portlet from the Execute onmenu.

4. Add content to the script. The following is a content example:
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5. After you save your new Heatmap Portlet script, you can go to the Dashboard and add the
Heatmap Portlet to your dashboard view using the Dashboardmenu.

Add a Heatmap Portlet to Your Dashboard View
You can add the Heatmap portlet to your dashboard view, by selecting it from the Dashboardmenu.

Create or Edit a Heatmap Report
You can create a customized Heatmap report after you create a Heatmap portlet’s embedded
script. The new report will appear on the Reports menu under Heatmap Reports.

1. Go to the Scripts Manager page on the Administration tab.

2. Create a new Script in JavaScript and select to Execute on Heatmap Portlet.
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3. Add content to the script.

4. Open the Customizationmode in the Report tab.

5. Customize the Dashboardmenu by adding a new item for the Heatmap Reports group. The
following is a content example:

Structure Map Reports
As an HP EM administrator, you can use HP EM to create a structuremap of artifacts by business
function, which allows you to view the relationships between artifacts and the status of each
artifact. Users can group artifacts by defining DQL queries and colors, and canmodify the way that
artifacts are displayed by using a color renderer and legend renderer.

Another way to characterize structuremap reporting is as a boxed visualization of a data tree
structure. You can use a structuremap tomodel business capabilities, but the visualization itself is
not restricted to business capabilities. Each rectangular area contains boxes that can be nested
several levels. Boxes can be decorated to show dimensions of input data by using background
colors or border lines of varying widths. Unlike the heapmap report, the area size of a box is
calculated to fit. Several levels of boxes are shown at the same time.

For example, an out-of-box Capabilities to project mapping structuremap report shows business
functions as nested boxes. The box’s background color represents the cost of the projects
allocated to a business function. The box’s bold frame indicates that the function is going to retire.

HP EM (1.00)Page 58 of 94



User Guide
Chapter 8: Reports

A structuremap is defined in the web UI using amanaged server-side script that specifies how the
data and its dimensions are calculated and visualized. The structuremap is shown directly in the
web UI, either as a portlet (an area of the HP EM home page) or as a standalone report. Structure
map reports are recalculated every time the user accesses the report’s web UI page.

Creating Structure Maps
You can use HP EM to create structuremaps, an important tool to helpmanage infrastructure,
reduce ongoing costs, and increase areas of investment within your enterprise architecture.

To create a Structure Map portlet, first create an embedded script with Structure Map
execution on type.

HP EM (1.00)Page 59 of 94



User Guide
Chapter 8: Reports

1. On the Administration tab, go to Customization > Manage Scripts.

2. Click the Create new script icon to open theManaged Script editor.

3. Create a new Script in JavaScript and select StructureMap Portlet from the 'Execute on'
menu.

4. Add content to the script. The following is a content example :

5. After you save your new structuremap portlet script, you can go to the dashboard and add the
structuremap portlet to your dashboard view using the dashboardmenu.

Customizing Structure Maps
You can use HP EM to show the ongoing cost and areas of investment within your enterprise
architecture. Structuremaps are a unique visual tool that highlight these features andmore.

As an HP EM administrator, you can use HP EM to customize the look and feel of the structure
maps that you or other users create.

To customize structure maps:

1. On the Administration tab, click Customization > Manage Scripts. TheManaged Scripts
page opens.

2. Find the StructureMap script, and then open it.

3. You can customize the following properties:

Label: Label of StructureMap

Id: Identification of map, using different values to enable the user to add capability map
instances on the HP EM home page.

Dql: String Array, query data for map

Length of array is themaximum depth of the tree view

maximumNodesDisplayed: Number Array – Limits the item number for each query

Visualizations: Item Selector Array
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4. To control the rendering of the Item style, youmodify the legend is based on defined rules.

Visualization Structure:

Visualization [

Selector 1: [{selector 1 value 1, rule 1-1}, {selector 1 value 2,
rule 1-2}...],

Selector 2: [{selector 2 value 1, rule 2-1}, {selector 2 value 2,
rule 2-2}...],

…

Selector N: [{selector N value 1, rule N-1}, {selector N value 2,
rule 2-2}...],

]

Selector Item Structure:

5. You can also define a list of specified colors to display, and can alsomodify the capability map
using the renderer. In this example, definitions are set to display only two colors for minimum
cost andmaximum cost, and then the node item colors and legend item colors will be
calculated automatically for use throughout the capability map.
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Embed Structure Map Components
You can reuse content in a structuremap from themanaged script and thenmodify and place it in
the customization XML file as CDATA content. This enables display of structuremap components
directly on related artifact pages.

To embed structure map components:

1. Go to Administration > Customization > Manage Scripts, and then select a script with
StructureMap Portlet as Execution on Type.

2. Copy the contents of JSON Config, and then customize. The following shows an example:
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The resulting artifact page shows the embedded structuremap component below the Latest Events
section.
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3. To add amenu link to a structuremap page that will display in the Reports tab, add this code to
the script:

Your new menu link will appear when you access the Reports tab.

4. To add amenu link to a structuremap page that will display in the Catalog tab, add this code to
the script:

Your new menu link will appear when you access the Catalog tab.

Viewpoint Portlet Reports
HP EM viewpoint portlet reporting is displayed directly in the web UI to visualize pre-defined artifact
types along with the dependencies between those artifacts. It provides a view to the HP EM
repository artifact types and each type is displayed as a box with a number of matching artifacts.
The lines between the boxes represent relationships between artifact types. The boxes are
clickable to show the artifacts in a dialog window in which a selected artifact can be used to run
impact or dependency analysis that is then visualized directly in the viewpoint portlet.

Viewpoint portlets are defined by HP EMmanaged server-side scripts. The layout of the viewpoint
is specified by using an SVG file that you can create in Inkscape (see www.inkscape.org). If you
have installed the HP EM Extension for Inkscape, which provides a seamless integration between
Inkscape and HP EM, you can create an SVG file that can be used as a viewpoint. For more
information, see the topic Installing the HP EM Extension for Inkscape.
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Policy Radar Reports
HP EM policy radar reporting is a web UI portlet that displays a radar chart showing the difference
between the policy report’s actual and target compliance. By default, the policy radar displays all
policy reports available HP EM. The layout and contents of the radar can be customized using a
managed server-side script.
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Custom BIRT Reports
You can use the HP EMWorkbench to design custom reports. The reports are defined and
executed using Eclipse’s BIRT, which is a very powerful reporting system that includes the
reporting features such as report layout, data access, and scripting. For more information, see
http://www.eclipse.org/birt/ where you can find details about the technology used and a few report
examples.

BIRT report definitions can be deployed and used in HP EM. The BIRT execution engine is part of
HP EM and the report definitions are executed to create a custom report. Custom reports are
cached in HP EM and you can access them directly in the HP EMwebUI. Unlike other reports,
custom reports are provided as standalone documents (PDF or HTML) that can be easily
downloaded from HP EM.
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HP EM Extension for Inkscape
HP EM integrates with the open source Inkscape vector graphics editing tool via an extension
module. By using Inkscape, you can easily edit SVG graphic files and other graphical elements
residing in the HP EM datamodels.

Installing the HP EM Extension for Inkscape
Before you install the Inkscape EM extension, make sure that you have the following on your
system:

l Inkscape 0.48 forWindows (You can download Inkscape from: www.inkscape.org.)

l JDK version 1.7

To install the HP EM Extension for Inkscape:

1. Execute hp-em-inkscape-1.00.msi

NOTE: InkscapeMUST be installed before launching the installer.

2. After installation has finished, the add-in files MUST be place into the following directories:

File Name Directory

addArtifact.inx INKSCAPE_HOMW\share\extensions\

addLayer.inx INKSCAPE_HOMW\share\extensions\

publishToEAM.inx INKSCAPE_HOMW\share\extensions\

eamanager.py INKSCAPE_HOMW\share\extensions\

eamanager(folder) INKSCAPE_HOMW\share\extensions\

3. When you restart Inkscape, click on Extensions in themainmenu bar. EM will appear in the
list. Double-click it to open.

Using the HP EM Extension for Inkscape
By using the HP EM Extension for Inkscape, you can add artifacts or layers or publish your
graphics directly to EM.

To add an artifact:

1. Click Extensions > EnterpriseMaps > Add Artifact.

2. Input the exact values for the Label and the Artifact Local Name in the Add Artifact fields.

3. Click Apply to create the new artifact. Alternatively, you can click Close to exit without
creating a new artifact.

To add a layer:
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1. Click Extensions > EnterpriseMaps > Add Layer.

2. Input the exact values for the Label and the Artifact Local Name in the Add Layer fields.

3. Click Apply to create the new layer. Alternatively, you can click Close to exit without creating a
new layer.

To publish to HP EM:

1. Click Extensions > EnterpriseMaps > Publish to EM.

2. Input the exact values for the Viewpoint Name, EM Url, Username, and Password fields.

3. Click Apply to publish the new file to EM. Alternatively, you can click Close to exit without
publishing.

4. You can publish a single SVG file multiple times. Based on the file name, EM will do one of the
following actions:

a. Publish the new file if there is no SVG artifact having the same name already, or

b. Update the existing file if there is an artifact with that name.

5. After you publish, you can view the SVG artifacts in the EM catalog.

The new artifact and layer will appear in HP EM.

You can also view artifacts in the catalog.

Apply a New SVG File to Your EM Home Page
You can apply any SVG file you choose to appear on your EM home page.

To apply a new SVG file to Your EM home page:
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1. Log in to HP EM.

2. Go to the Catalog showing the list of SVG files and open the artifact that you want to use.

3. Copy its UUID to the clipboard.

4. Go to the Administration tab > Customization > Manage Scripts, and then open the Archimate
Introductory Viewpoint.

5. Click Edit Script, and then paste the UUID into the config.viewPointuuid value. When you
finish, save the script.

6. Go to the Catalog tab and right click on your home page dashboard. The context menu will be
displayed.

7. Click Archimate Introductory Viewpoint and the new file will display.

Using the Log Files for the HP EM Extension for Inkscape
You can use log files to track or investigate any errors that occur. The log files are located at:

INKSCAPE_HOME\share\extension\em\log

There are two log files to use:

l The file inkscape.log contains the trace output for adding artifacts and layers.

l The file publish.log contains trace output for publishing of SVG files to HP EM.
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Scripted XML Publishing
HP EM supports "Scripted XMLPublishing" where HP EM is extended with script artifacts. These
script artifacts contain instructions of how to recognize/parse new XML document types that are
imported from the web UI. The script artifacts:

l Can be created/modified/deleted anytime

l Modify HP EM publishing pipeline immediately without the need of applying extra extensions or
a server restart

l Can be easily bundled (by PSO) in amodel extension to provide a default way of how to publish
new document types/artifacts

l Are written in a XML format, the structure is expressed using XML schema (XSD); your XML
editor can be easily configured to provide hints and help regarding script structure

l Are controlled for XML schema validity and passes semantical analysis upon every change
(create/update), invalid scripts cannot be published

Creating Scripted XML Artifacts
The script can be published to HP EM using the following simple steps.

To create a scripted XML artifact:

1. Select theAdministration Tab > Customization > Manage Scripts.

2. Click theCreate new script icon to open theManaged Script editor.

3. Enter a unique name (spaces are OK) and an optional description.

4. ForScript Language, select XML.

5. ForExecute On, select XML Data Import.

6. Click Save.
A view page of the script opens.

7. Click theEdit Script button on the right to open a blank Edit script dialog.

8. Enter the script content and click Save. You can copy and paste the script from a text file.
For example, you could enter the following script:

<publisherConfiguration
xmlns="urn:com.hp.systinet.publishing.xml:1.0"
name="simpleBook">
<artifact sdmName="documentationArtifact">
<recognition>
<rootElement name="book" namespace=""/>
</recognition>
<stringProperty sdmName="name">
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<text>BOOK: </text>
<xpath>name/text()</xpath>
</stringProperty>
</artifact>
</publisherConfiguration>

Every successfully saved script is active immediately. You can now import and publish a book
file. See "Importing and Publishing a Book File" (on page 72).

Importing and Publishing a Book File
To import a book file:

1. Select theCatalog tab > Import > File.

2. Change File toURL and enter the URL of the simple book.

3. Click Import. A documentation artifact is created.

For Example: If the script content of the book is the following:

<?xml version="1.0" encoding="UTF-8"?>
<book xmlns="urn:simpleBook">
<name>Dunno on the Moon</name>
</book>

A documentation artifact is created and the name of the created artifact is BOOK: Dunno on the
Moon.

Script Properties
This topic describes:

l "Enhanced Script Components" (on page 72)

l "Script Elements and Attributes " (on page 73)

Enhanced Script Components
The script is enhanced with the following parts:

l namespace is urn:com.hp.systinet.publishing.xml:1.0

l root element is publisherConfiguration
n The root element should have the name attribute to identify the script by name. The name

must be unique between all publishing scripts.

l optional registration element is important during recognition of a document/file type. For details
see "Recognition Order" (on page 77).

l optional namespaceContext element defines mapping from prefix to namespace. This mapping
is supplied to all xpath elements (xpath,select) in the script.

l recognition and parsing of input filesare controlled by nested artifact elements, which are
optional (but a script without artifact elements is useless).
n each artifact must have the sdmName attribute that matches an existing SDM artifact type

name.
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n an artifact element can bemarked with enabled='false' to ignore the artifact during publishing.

Script Elements and Attributes
The script is supported by the following elements and attributes:

l "Artifact Recognition " (on page 73)

l "Extractors" (on page 73)

l "Artifact Properties " (on page 75)

l "Relation Property" (on page 76)

l "Recognition Order" (on page 77)

l "Variables" (on page 78)

Artifact Recognition
The recognition element defined in the artifact element is used to describe how the publisher can
recognize the input document/file. The recognition element can contain multiple sub-elements. The
artifact element recognizes the input if all recognition's children elements evaluate to true.

The following recognition elements are supported:

l and is a container element that returns true only if all nested recognition elements returns true.
The artifact's recognition element is an and in fact.

l or is a container element that returns true only if at least one nested recognition element returns
true.

l not returns true if themandatory nested recognition element returns false.

l rootElement can contain namespace and name attributes, returns true only if (all) the following
conditions are true.
n name attribute is not supplied or root element local-name (namewithout namespace prefix)

equals to name attribute value.

n namespace attribute is not supplied or root element namespace equals to namespace
attribute value.

l xpath contains text with an xpath expression, returns true only if the xpath expression is true
(non-empty node-set also yields to true).

l empty is a container element that returns true only if all nested extractors create empty value.

l extension contains text with a required extension. Returns true only if the input file extension is
exactly the same. the extension always start with ".", for example ".xml" or ".doc".

l any can contain nested extractor element, it returns true only if
n it does not contain a nested extractor element.

n or the extractor extracts a non-empty string.

l xml returns true only if the input document was fully parsed and it is a valid XML file.

Extractors
Extractors are used to extract string data out of the input (file/document or document part).
Extractor elements are obviously used to define artifact property value, but they can be also used to
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recognize data (using empty or any recognition elements described in the Artifact recognition
section) or define variables (see "Variables" (on page 78)).

The following extractors are supported:

l all is a container extractor that returns concatenation of values that are created by nested
extractors.

l first is a container extractor that returns the value of the first nested extractor that creates a
value.

l for-each is a container extractor that returns concatenation of nested extractors evaluated
against each node in the node list defined by the select element; it has to contain:
n select element as a first element with a text defining an xpath to extract a node list.

n at least one extractor element to extract data for an element in the node list.

l xpath returns a string value that is a result of xpath evaluation, where xpath is a text value of this
element; xpath valuemay only use namespace prefixes defined by namespaceContext
element (defined as a direct child of the root element of the script).

l regexp is a container extractor that concatenates the output of all nested extractors and then
applies a regular expression pattern to the extracted value. The patternmust be specified in the
pattern attribute. It returns a value only if the patternmatches. The value is then either the first
substitution group found in the pattern or the wholematched string if there is no substitution
group in the pattern.
n example1: input "file.xml", pattern ".xml$" ... does not match

n example1: input "file.xml", pattern "^.*\.xml$" ... matches and output is "file.xml"

n example2: input "file.xml", pattern "^(.*)\.xml$" ... matches and output is "file"

l replace is a container extractor that concatenates the output of all nested extractors and then
replaces all occurrences of supplied regular expression pattern (usingmandatory pattern
attribute) by the value supplied in themandatory replacement attribute.

l text returns the value of the text content.
n example: <text>This is a constant value</text>

l location returns the location of the input file as it would appears in the repository location space.

l variable returns the value of the variable. It supports the following attributes:
n name is a mandatory variable name.

n default is an optional default value if the variable is not defined.

n scope is an optional scope to look for variables (local, shared, all).

l substituteVariables is a container extractor that concatenates the output of all nested
extractors and then replaces all occurrences of supplied regular expression pattern (using
mandatory pattern attribute) by variables. Themandatory pattern attributemust contain a
substitution group to know the name of the variable.
n Example:

If you input: "This is ${NAME}", pattern is "\$\{.*\}"; if NAME variable is defined to "Pavel".

Then the output is: "This is Pavel", otherwise the output is "This is ${NAME}."
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l if extracts a value when a conditionmatches, it has to contain nested
n condition element that with the condition expressed as recognition element, it is in fact an

and extractor container.

n value element that with the value, it behaves as all extractor container.

Artifact Properties
There are several types of artifact properties, the handling of the property depends on the property
type. The way how the properties are set to artifact is defined by any of the supported property
element of the script's artifact element. These are:

l stringProperty defines string/text property with single occurrence(0..1 or 1..1)

n is an instance of all extractor element, nested elements extracts a text value that is set, the
property value depends on property type:

string— the text is set as property value

boolean— the value is true only if the text is "true", false otherwise

category — the text is a category value, which is used to create a category value

nameUrlPair— text is set to the URL portion of the property value

l booleanProperty defines boolean property with single occurrence
n is an instance of and recognition element, nested elements evaluate the input as either true or

false.

l integerProperty defines integer property with single occurrence
n is similar to stringProperty, but the value is parsed to be an integer

l dateProperty defines date property with single occurance, it has
n zero, onemore format elements that are used to try parsing the value in the order that they

appear, the content of the format element is a string, one of the following values are accepted:

n epoch - a long value is expected as a count of milliseconds from epoch (the date is then
constructed using new java.util.Date(millis))

n current independently on value, it result in a current Date

n default default format is ISO8601 (SimpleDateFormat with yyyy-MM-
dd'T'HH:mm:ss.SSS'Z' pattern in "UTC" timezone and lenient parsing)

n any other value is used as a pattern to create java.text.SimpleDateFormat

l the format element can have the following attributes
n lenientmeans that the parsing will try some heuristics with inputs that do not strictly match

the pattern, true by default

n timezone is a timezone string see java.util.TimeZone for details

l value is an all extractor that specifies the value to extract from

l categoryProperty defines a category property by using either
n only a value attribute is used to specify a category value, associated category's tModelkey

and name are obtained from the property descriptor and HP Atlas database. The category
value is validated during creation of the script, it has to be a category of a checked taxonomy.
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n a val element can be used to specify an all extractor that extracts the category value from the
input; name (3rd) and taxonomyUri (1st) are other optional elements that are all extractors as
well.

n if the taxonomyUri is not specified, category's taxonomyURI is obtained from associated
property descriptor (recommended)

n if the name is not specified, category's value is queried from the HP Atlas database using
taxonomyURI and value

l relation defines relational property with single occurrence and it is quite complex to understand,
see "Relation property" section below.

l multiProperty defines property with multiple occurrences (?..n) using nested select element
and one 'single occurrence' property. The select element must be the first, it defines an xpath
expression that used to split the present input into a node list, where each node is then used to
parse a single occurrence property.

Each 'single occurrence' property has an 'sdmName' attribute that carries the name of the property
according to SDMmodel, it can also contain a flag attribute identifier. All artifact's properties that
aremarked as identifiers are considered to be a composed identifier of the artifact, which is used
when finding duplicates. A new artifact is considered as a duplicate if it has the same SDM name
and identifiers of another artifact that already exists.

Relation Property
Unlike other properties, the value of the relation property is not known from the input. The value
value of the relational property represents a connection to another artifact, that need not exists
during the publishing. The process of creating a relation can typically create also a target artifact.

Each relation element must have sdmName attribute to define property name in the SDMmodel.
There are the following type of relation properties:

l relation to local artifact means that relation's second side (target) is an artifact instance that
exists (or is created) locally for this artifact. It is defined with
n targetType attribute undefined or set to "localArtifact".

n Nested artifact element that defines the target artifact; in order to resolve duplicates, at least
one property should bemarked by identifier attribute set to true.

n Semantical example: book with chapters where
o chapters are local to the book

o more chapters with the same name can exist in the repository

l file referencemeans that a relation is represented by another file in the input. It is defined with
n targetType attribute undefined or set to "importedResource"

n Nested import element that defines how to include the resource. The import element must
contain these elements:
o relativeLocation element being an all extractor that is supported to create relative or

absolute URL that can be used to download the resource.

o targetSdmName elements can follow, each with a text value that must be an SDM name
of expected target artifact; targetSdmName elements can be only used to enforce
specific target artifact sdm names, when no targetSdmName is present, the target types
are taken from the relationship descriptor.

HP EM (1.00)Page 76 of 94



User Guide
Chapter 10: Scripted XMLPublishing

n Semantical example: a library references a large number of books. An HTML page references
images and CSS files.

l relation to shared artifact, it means that relation's second side (target) must be a shared
artifact instance. It is defined with the following:
n targetType is used to set up amethod of how to find a shared artifact.Following aremethods

used:
o repositoryReference - a matching artifact is searched the repository.

o sharedReference - a matching artifact searched in the publisher input; if it is not found,
use repositoryReference.
o publisher input contains all resources that were recognized in the "still running"

processing; including locally decomposed artifacts, imported resources, and all files in
the zip file.

o sharedArtifact - if no sharedReference is found, create a new artifact

n Nested artifact element that defines the target artifact; in order to resolve duplicates, at least
one property should bemarked by identifier attribute set to true.

n Semantical example: book with author where
o author is assumed to be only one author in the repository.

o author is shared between books.

Recognition Order
The publishing pipeline internally manages a list of DocTypeFactory instances, these instances are
called (in the list order) to create DocType instances that are asked to recognize the input. The first
DocType that recognizes the input is used to parse the data and eventually create artifact(s). A
DocTypeFactory instance is created by runtime for every publishing script, the factory creates
DocType for every artifact element in the script (in the same order). The server log contains INFO
messages that describe the order of DocTypeFactory instances, these INFOmessages are
generated during HP Atlas EAR initialization or upon a change in publishing scripts
(create/delete/update).

14:17:09,369 INFO [PublishingScriptsRegistration] Registering
factories:
14:17:09,369 INFO [PublishingScriptsRegistration]
ScriptedDocTypeFactory[bookWithChapters_withVariables]
14:17:09,370 INFO [PublishingScriptsRegistration]
ScriptedDocTypeFactory[simpleBook]
14:17:09,370 INFO [PublishingScriptsRegistration]
ScriptedDocTypeFactory[helloworldPublisher]
14:17:09,370 INFO [PublishingScriptsRegistration]
ScriptedDocTypeFactory[simpleUddiPublisher]
14:17:09,371 INFO [PublishingScriptsRegistration] DocTypeFactoryImpl
[sc-publishing-ext.docTypes]
14:17:09,371 INFO [PublishingScriptsRegistration] DocTypeFactoryImpl
[sc-publishing-sca.docTypes]
14:17:09,371 INFO [PublishingScriptsRegistration] DocTypeFactoryImpl
[sc-publishing-wsdl.docTypes]
14:17:09,372 INFO [PublishingScriptsRegistration] DocTypeFactoryImpl
[sc-publishing.docTypes.default]
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DocTypeFactoryImpl instances are built-in factories that are used to recognizedWSDL, SCA,
XPDL etc document. These are by default at the bottom of the list. The ScriptedDocTypeFactory
instances are created out of publishing scripts. The order in which DocType instances are asked if
they recognize the input can be changed in the script. You can

l Add a registration element as a first child of the publishing script's root element. This element
can contain multiple after or before elements, both with mandatory text content that should be
the factory name (script name in the case publishing script), for example
<after>helloworldPublisher</after><before>simpleUddiPublisher</before>. Note that the
names are listed in the log. Youmay also use the names of built-in DocTypeFactoryImpl
instances if required.

l Change the order of artifact elements in the particular publishing script will change the
recognition order managed by the ScriptedDocTypeFactory.

Variables
Variables can be used to simplify and/or speed up the script execution. A variable can be set using
optional setVariable element that can occur multiple times as a first child of the artifact element.
The setVariable element contains

l Optional scope element that identifies the scope of the defined variable(s), localmeans local for
the published file/document, sharedmeans a variable that is visible between all published files

l Mandatory name element is an all extractor and defines variable name

l Mandatory value element is an all extractor and defines variable value

l Optional select element can be used to set upmultiple variables, the select element text must
be an xpath expression that is used to create node list, each node in the list is then used to
define variable (using extractors of setVariable's name and value elements)

Variables are used in variable or substituteVariables extractors, which are explained in the
"Extractors" section above.

Readmore supported elements and attributes in publisherConfiguration_1.0.xsd.

Scripted XML Samples
The following topics provide different use-case samples:

l "Sample 1: Publish a Book With All Its Chapters" (on page 78)

l "Sample 2: Cross-Reference to Another Book" (on page 80)

l "Sample 3: Ignore Some Book Files or Document Types" (on page 80)

l "Sample 4: Books Share the Same Author" (on page 81)

Sample 1: Publish a Book With All Its Chapters
Youwant to publish a book with all its chapters, which are artifacts connected to the book. A single
input book file now differs:

l It has a namespace "urn:bookWithChapters"

l It has children element chapter, each chapter having attribute "name" with chapter name
<book xmlns="urn:bookWithChapters">
<name>Dunno on the Moon</name>
<chapter name="The mystery of moon stone"/>
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<chapter name="Upside down"/>
<chapter name="Start"/>
<chapter name="Landing"/>
<chapter name="The first day on the Moon"/>

</book>

The associated script is:

<publisherConfiguration
xmlns="urn:com.hp.systinet.publishing.xml:1.0"
name="bookWithChapters"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:schemaLocation="urn:com.hp.systinet.publishing.xml:1.0
publisherConfiguration_1.0.xsd">
<namespaceContext>
<namespace prefix="b" uri="urn:bookWithChapters"/>
</namespaceContext>
<artifact sdmName="documentationArtifact">
<recognition>
<extension>.xml</extension>
<rootElement name="book" namespace="urn:bookWithChapters"/>
</recognition>
<stringProperty sdmName="name">
<text>BOOK: </text>
<xpath>b:name/text()</xpath>
</stringProperty>
<multiProperty>
<select>b:chapter</select>
<relation sdmName="r_consistsOf" targetType="localArtifact">
<artifact sdmName="documentationArtifact">
<stringProperty sdmName="name" identifier="true">
<text>CHAPTER '</text>
<xpath>@name</xpath>
<text>' of '</text>
<xpath>/b:book/b:name/text()</xpath>
<text>'</text>
</stringProperty>
</artifact>
</relation>
</multiProperty>
</artifact>
</publisherConfiguration>

Create the script using the Administration tab in HP EM. Then import an example file (Catalog tab
>Import > File). The result is a documentation artifact BOOK: Dunno on the Moon that has a
relation that consists_of' 5 documentation artifacts named

l CHAPTER 'Themystery of moon stone' of 'Dunno on theMoon'

l CHAPTER 'Upside down' of 'Dunno on theMoon'

l CHAPTER 'Start' of 'Dunno on theMoon'
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l CHAPTER 'Landing' of 'Dunno on theMoon'

l CHAPTER 'The first day on theMoon' of 'Dunno on theMoon'

Sample 2: Cross-Reference to Another Book
Assume that the book requires another book in order to know the context before reading. A book
XML file is now modified with reference to another book (as a relative/absolute URL). using
readAfter elements:

<book xmlns="urn:bookWithChapters">
<name>Dunno on theMoon</name>
<chapter name="Themystery of moon stone"/>
<chapter name="Upside down"/>
<chapter name="Start"/>
<chapter name="Landing"/>
<chapter name="The first day on theMoon"/>
<readAfter ref="./bookWithChapters_sunCity.xml"/>
</book>

The associated changed publishing script adds the following property definition:

<multiProperty>
<select>b:readAfter</select>
<relation sdmName="r_dependsOn">
<import>
<relativeLocation>
<xpath>@ref</xpath>
</relativeLocation>
<targetSdmName>documentationArtifact</targetSdmName>
</import>
</relation>
</multiProperty>

Use the administration UI to update the script with the reference. Then you can re-import (Catalog
tab, Import/File). Now the publishing includes also the reference, the result now contains:

l A new 'BOOK: Dunno in Sun City' documentation artifact with 2 chapters (document artifacts)
that are connected.

l 'BOOK: Dunno on theMoon' now has relationship 'r_dependsOn' to 'BOOK: Dunno in Sun City'.

Sample 3: Ignore Some Book Files or Document Types
In some cases, HP EMmay need to ignore some book files or document types during publishing.
This usecase is also supported by scripted publishing.

An artifact element can have attribute enabled set to false to ignore the recognized input file. For
example: the following artifact element in your script will ignore books that have no chapters:

<artifact sdmName="documentationArtifact" enabled="false">
<recognition>
<xpath>/b:book[not(b:chapter)]</xpath>
</recognition>
</artifact>
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Modify the existing to have the above artifact element as a first artifact and then import data file.
The publishing will result with amessage "Nomodification". The file bookWithoutChapters.xml will
not be imported, and thus ignored.

Sample 4: Books Share the Same Author
Authors (unlike chapters) are shared between books, the author is a sharedArtifact between all
books in the repository.

The associated changed publishing script adds the following property definition:

<multiProperty>
<select>b:author</select>
<relation sdmName="documentationOf" targetType="sharedArtifact">
<artifact sdmName="personArtifact">
<stringProperty sdmName="name" identifier="true">
<xpath>text()</xpath>
</stringProperty>
</artifact>
</relation>
</multiProperty>

Create the script using administration UI. Then import an example file:

<?xml version="1.0" encoding="UTF-8"?>
<book xmlns="urn:bookWithChapters">
<name>Dunno on theMoon</name>
<author>Nikolay Nosov</author>
<chapter name="Themystery of moon stone"/>
<chapter name="Upside down"/>
<chapter name="Start"/>
<chapter name="Landing"/>
<chapter name="The first day on theMoon"/>
<readAfter ref="bookWithChapters_sunCity.xml"/>
</book>

The books will then contain a shared reference to a person artifact Nikolay Nosov.
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Integrations
HP EM integrates by importing and synchronizing with the following products:

l HP Project & Portfolio Management (PPM), see "PPM Integration" (on page 82)

l HP Universal ConfigurationManagement Database (UCMDB), see "UCMDB Integration" (on
page 87)

PPM Integration
HP EM integrates (imports and synchronizes) the following areas of the HP PPM (Project &
Portfolio Management) software with Enterprise Architecture: Project, Financial and Demand
Management.

The PPM software is a primary source of financial and project information about applications in the
corporation. The HP EM integration and synchronization with PPM provides useful financial
insights into enterprise architecture. HP EM can generate views showing architecture aligned with
demandmanagement, project, and asset management, including financial views from PPM. The
PPM artifacts can bemodified in HP EM and then exported back to PPM.

You can also customize the HP EM synchronization with other PPM software vendors. HP EM
synchronization is not limited to one PPM endpoint. See "Customize and Export PPM
Synchronized Data" (on page 86) for details.

Only the Administrator role can synchronize HP EMwith HP PPM.

Import and Synchronize PPM Data
You can import and synchronize the associated PPM data with HP EM.

To import and synchronize PPM data with HP EM:

1. Select theAdministration tab > Configuration > Integrations.

2. Click Add Server inside the PPMRepositories section to create a new PPM repository for the
PPM synchronized data. The PPMRepository opens.
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3. Enter the following information:
n Name (Required): Server name

n Description (Optional): Enter a description of the PPM repository.

n Base URL (Required): PPM Server URL

n Username (Required): Server login username

n Password (Required): Server login password

4. Click Save.

5. Click the Associated Import Task icon (third icon from the left at the toolbar).

The Import page opens.

6. Click the Run icon to start the synchronization, and confirm the decision. The import runs in the
background, whichmeans that you can perform other tasks without interrupting the import.

7. The import takes less than 10minutes. During the import you can see the synchronized data
being added in Projects, Application components andGoal collections in the Catalog as a
result of the task.

8. If you worked on another task during the import and want to see the import results, do the
following:
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a. Select theAdministration tab > Configuration > Integrations.

b. Select the new PPM repository you just created.

c. Click the Associated Import Task icon to see the Execution History on the Import page.

View PPM Imported Data
You can view PPM imported data in HP EM as normal artifacts in the PPM repository and as
artifact reports (Projects or Applications). Some PPM data can also be viewed as graphical
diagrams such as a Heatmaps Report showing Projects By Cost or Applications by Cost.

PPMMapped Data

The PPM data is mapped to HP EM data, with the same corresponding relationships:

l PPM assets aremapped to HP EM Application Component artifacts and corresponding
Application Component Financial Profile artifacts.

l PPM projects aremapped to HP EM Project artifacts and corresponding Project Financial
Profile artifacts.

l PPM business objectives aremapped to HP EMGoal artifacts.

On HP EM, the PPM data can be viewed as “Relationships” as seen in the Overview tab or
Relationship tab when you view the Artifacts.

On PPM, you can see the assets on “Project Details” or “References” section of the corresponding
Project/Asset.
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PPM Reports

You can view imported reports of PPM projects and applications, as well as all imported PPM
records as HP EM Application Component artifacts. In each case, when you click on a PPM
artifact, you can then click on the PPM Link to see the artifact's corresponding asset in the PPMUI.

To view the PPM reports and see the corresponding asset in the PPM UI:

1. Open the projects, applications or imported records:

a. To see a list of the PPM projects,select theReports tab > All Reports > Artifact
Reports > Projects.

b. To see a list of the PPM applications, select theReports tab > All Reports > Artifact
Reports > Applications.

c. To see the list of all imported PPM records, select theAdministration tab >
Configuration > Integrations > PPM Repositories > <PPM_repository>.

2. In any of these lists, click on a PPM artifact to open the artifact Overview page.

3. Click on theMore icon (the last icon with three dots) to open themenu and select the PPM Link
at the bottom of themenu.
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The PPMUI opens on a new tab in the browser to the corresponding PPM asset information. (If
you are not already logged in to PPM, you will be directed to the login page and then redirected
to the corresponding PPM asset.)

Customize and Export PPM Synchronized Data
You can customize and export PPM synchronized data in HP EM and export the data back to PPM.

To customize PPM synchronized data:
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1. Select theAdministration tab > Configuration > Integrations.

2. Click the< PPM_repository> in which you want to edit an artifact's properties.

3. Click the artifact to be edited and click the Edit icon.

4. Make your changes and click Save.

To export the customized PPM synchronized data:

1. Still in the artifact properties page, click theMore (3 dots) icon and select Export.

2. Click theExport button.
The export process exports all dependencies by default. If you want to export only aggregates
without dependencies, open AdvancedOptions and uncheck the Include Dependencies
option.

A confirmation dialog pops up confirming the export was completed.

Purge Artifacts From the PPM Repository
As the Administrator youmay want to clear the data.

To purge all connected artifacts from the PPM repository:

1. Select theAdministration tab > Integrations > <PPM_repository>.

2. Click the Expert tools icon and select Purge all connected artifacts.

3. Click Yes to confirm the purge.

UCMDB Integration
HP EM integrates UCMDB (Universal ConfigurationManagement Database) software with
Enterprise Architecture.

UCMDB is a primary source of information about runtime systems. (HP EM) can import and
synchronize relevant data from UCMDB configuration items (CIs). This gives the architect up-to-
date data about the baseline architecture at the Technology layer and brings visibility on the as-is
state. The enterprise architect can reuse the imported UCMDB CIs and link them to the application
architecture to provide traceability between the application and technology layer.

Import and Synchronize UCMDB Data
You can import and synchronize the associated UCMDB data with HP EM.

Only the administrator role can synchronize HP EMwith HP UCMDB.
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To import and synchronize UCMDB data with HP EM:

1. Select theAdministration tab > Configuration > Integrations.

2. Click Add Server under the BSM/UCMDB Repositories section to create a UCMDB
repository for the synchronized data.

The BSM/UCMDB Repository opens.

3. Enter the following information:
n Name (Required): BSM/UCMDB Repository name.

n Base URL: Server URL.

n Username: Server login username.

n Password: Server login password.!

4. Click Save to save the data.

5. Click the Associated Import Task icon (third icon from the left at the toolbar).

The Import page opens.

6. Click the Run icon to start the synchronization and confirm the decision.

The import starts asynchronously in the background so that you can continue with other tasks.
The import takes less than 10minutes.

7. To see the progress of the new data as it is loaded, select the Catalog tab and view the Artifact
Statistics on the Catalog home page.
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You can schedule the task to run periodically.

View UCMDB Tasks
You can view the UCMDB task status or open the details of the current synchronization.

To view UCMDB tasks:

1. Select theAdministration tab > Configuration > Tasks and click the Show Task List icon.

The data acquired by HP EM from the sample UCMDB server is connected with the
<UCMDB_repository>.

2. Click on a task to see the status.
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Purge Artifacts From the UCMDB Repository
As the Administrator youmay want to clear the data.

To purge all connected artifacts from the UCMDB repository:

1. Select theAdministration tab > Integrations > <UCMDB_repository> repository.

2. Click the Expert tools icon and select Purge all connected artifacts.

3. Click Yes to confirm the purge.
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Extension for Sparx EA
HP EM integrates with the widely used Sparx Systems EA datamodeling tool via extension
module. The Extension for SPARX EA is a fully integrated datamodeling environment for you to
use with HP EM. The HP EM user is able to synchronize datamodels bi-directionally using the
extension.

Installing the Extension for Sparx EA
You can install the HP EM Extension for Sparx EA to extend your local installation of Sparx EA in
order to synchronizemodels with the HP EM server.

Youmust already have Sparx EA version 10 installed.

To install the HP EM Extension for SPARX EA:

1. Close Enterprise Architect 10 if it is running.

2. Run the installer hp-em-sparx-1.00.msi

3. Click Next until the final wizard panel appears, and then click Finish.

WARNING: Sparx EA stores the HP EM user password(s) using a Triple DES password
encryptionmethod.

User passwords are stored outside the HP EM server, thus bypassing HP security policies, and
may be subject to security issues such as decryption or corruption.

Uninstalling the Add-In for Sparx Enterprise Architect
Before you install a new version of the HP EM Extension for Sparx EA, it is helpful to uninstall any
existing version on your system.

To uninstall the HP EM Add-In:

1. Close Enterprise Architect 10 if it is running.

2. Open the Control Panel > Programs > Programs and Features.
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3. Select the program from the list, and then click Uninstall.

Getting Started with the Extension for SPARX EA
When building datamodels in HP EM, Sparx EA users can access Archimate 2.0 elements using
the following steps:

1. Display Toolbox by clicking Diagram > Diagram Toolbox in theMainmenu.

2. Display elements of an Archimate 2.0 layer by clickingMore tools, and then select the layer for
your model.

3. You can create new elements by dragging them from the Toolbox to a working diagram.
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4. In a working diagram, you can create a link between elements by dragging the arrow (quick linker)
from a selected element to another element.

5. After linking elements, Sparx EA will ask for a link type. Define the relationship between
elements using the link typemenu.

6. You can create a new element together with a link by dragging the arrow from a selected element
to an empty area of your diagram.

7. Sparx EA prompts you for a target element type and link type after you stop dragging the arrow.
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8. Sparx EA opens a dialog that allows you to specify element properties. After you click OK, the
element is created along with the link.

Supported Versions
The HP EM Extension for SPARX EA currently supports only the Archimate 2.0 specification.

l Archimate 2.0 is now available as a feature of Sparx EA version 10.

l HP EM Extension for Sparx EA mapping configuration supports only synchronization elements
having Archimate 2.0 stereotypes.
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